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Introduction

The SQQ32 Serial Number Tracking Software was developed to serve as an SQQ32 Serial Number data repository and to facilitate writing SQQ32 Serial Number data to contact memory buttons. This software provides these capabilities:

· Operates on a default MS-Access database file

· Able to create new database files

· Stores serial number data as described in the Data Element Dictionary

· Add new records

· Edit existing records

· Delete existing records

· Able to use Contact Memory ButtonLasers, and ButtonLinks

· Reads CMB data 

· Writes CMB data

· Loads ButtonLaser software

· Clears data from ButtonLasers

· Prepares ButtonLaser batteries for recharging

· Performs Inventory Reconciliation between database and collected data 

Serial Number Tracking Software Load Procedures

Installing from CD

Insert the SQQ32 Serial Number Tracking CD into your CD Drive.

Select Run from the Taskbar Start menu, type the following D:\setup.exe ( substitute your CD drive letter), and  press the Enter key. 

Follow the prompts and accept the default selections. If any warnings appear regarding attempts to load older files, always choose to keep the newest file.

The default program’s file location is c:\Program Files\ Serial Number Tracking System\Inventory.exe

Know Problems with setup program.

When installing the software you might experience some error during the setup, due to DLL already installed in your computer.  

First error

Press Ignore to continue setup.
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Second error

Press Yes to continue setup
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Third error

Press Ignore to continue setup
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Fourth error

Press Ignore to continue setup
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Creating a shortcut

A shortcut is a quick way to start a program or open a file or folder without having to go to its permanent location in Windows Explorer. Shortcuts are especially useful for programs, files, and folders you use frequently. There are three ways you can create a shortcut:

To create a shortcut in a folder 

1. In My Computer or Windows Explorer, click the folder in which you want to create the shortcut. 

2. On the File menu, point to New, and then click Shortcut. 

3. Follow the instructions on the screen

To put a shortcut on the desktop 

4. In My Computer or Windows Explorer, click the item, such as a file, program, folder, printer, or computer, for which you want to create a shortcut. 

5. On the File menu, click Create Shortcut. 

6. Drag the shortcut icon onto the desktop. 

Notes 

· To change any settings for the shortcut, such as what kind of window it starts in, right-click the shortcut, and then click Properties. 

· To delete a shortcut, drag it to the Recycle Bin. The original item still exists on the disk. 

To add a new submenu to the Programs menu 

7. Right-click Start, and then click Open. 

8. Click the Programs folder to select it. 

9. Click the File menu, point to New, and then click Folder. 

10. Type the name that you want to use for the submenu. 

11. Press ENTER, and then open the folder you just created. 

12. On the File menu, point to New, and then click Shortcut. 

13. Use the Create Shortcut wizard to add items to the submenu.

Running the program for the first time.

When the program starts the user will be asked to enter the user name and password assigned to he/she by the system admin.
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After the user login when the program starts the for the first time, it will require you to setup the communication options.

This is very critical, make sure you select the right options for the communications port and contact memory device used. The program will automatically select the highest baud rate for the chosen device. The view screen option is used to trace the communications with the device. After selecting your options press ok to save the selections.
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Serial Number Tracking Operators Guide

This section of the manual identifies and describes each of the menu items available within the Serial Number Tracking program. The section is organized by menu group: Buttons, File, Edit, View, and Tools.

Buttons
Add a Part Button
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Click on the Add a Part. This will open the a new form allowing user to enter a new Part Data information. After pressing the OK button will open the form in edit mode allowing user to add the remaining data. 

Add Nameplate data
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Add Warranty Data.
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Add Remarks Data
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Save the record when done.

Edit Part Data Button

Click on the Edit Record. This will open the form in edit mode allowing user to edit existing records.
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Edit Nameplate Data.
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Edit Warranty Data. 
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Edit Remarks Data.
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Save the record when done.

Delete Part Button
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Click on the Delete Part. This will allow the user to delete existing Part records. The System will ask to confirm the delete action.

Delete Serial Item Button
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Click on the Delete Serial Item. This will allow the user to delete existing Serial records. The System will ask to confirm the delete action.

Add a Serial Item Button.
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Click on the Serial Item. This will open the a new form allowing user to enter a new Part Data information. After pressing the OK button will open the form in edit mode allowing user to add the remaining data. 

Add Nameplate data
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Add Warranty Data.
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Add Remarks Data
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Save the record when done.

Copy Serial Item Button

Click on the Copy Serial Item. This will create a new serial number record and open the form in edit mode allowing user to edit the records.
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Edit Nameplate Data.
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Edit Warranty Data.
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Edit Remarks Data.
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Save the record when done.

FILE

File/New Database
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On the SNT bar click file or New Database,

The program allows the user to select or create a new database the default database is Inventory.mdb.
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If the file you want is in a folder, double-click the folder. Double-click the file you want to open.

File/Open Database
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On the SNT bar click file or Open Database,

The program allows the user to select or Open a database the default database id Inventory.mdb.
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If the file you want is in a folder, double-click the folder. Double-click the file you want to open.

File/Export Database

On the SNT bar click file or Export Database,

The program allows the user to Export the data and create a text file.
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If the file you want is in a folder, double-click the folder. Double-click the file you want to use or type a new file name. 

Edit

Edit/Cut, Copy, Paste
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On the Edit menu, click Cut. 

In the document where you want the information to appear, click the place where you want to put the information. On the Edit menu, click Paste. 

The information is removed from the original document and is placed in its new location. 

On the Edit menu, click Copy.

In the document where you want the information to appear, click the place where you want to put the information. On the Edit menu, click Paste. 

The information is copied from the original document and is placed in its new location. 

Edit/Find Record

On the Edit menu, click Find Record. This selection will allow the user to search for a record in the database. Select Serial number and Part Number from drop-down list box and press ok to start the search.

Edit/Options

The Edit/Options menu item allows you to customize certain parameters that affect the program operation. The Paths tab provides selections for a default path and a default database file.
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Choose the top Browse button to select a default directory.
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Select the lower Browse button to choose a default database file.

The Communications tab is used to setup the communications parameters for the contact memory device that will be used. This tab allows you to switch devices at any time. Select the communications port to which the contact memory reader device is attached.  Select the type of device that will be attached.  This will automatically cause the highest available baud rate to be selected. The View screen option toggles on and off the display 

of the communication session between the PC and the reader device.
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View

View/Form

The View/form Menu item switches the display from list mode to form mode as display below. Form mode displays a single record and is capable of showing all data elements. Form mode is also the only view that allows data to be added, edited, or deleted.

Form Nameplate Data
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Form Warranty Data
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Form Remarks Data
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View/List

The View/List menu item will display the data in a list, or spreadsheet, fashion.  Use the scroll bar to view data to the left or right of the current view.
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List Nameplate Data
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List Warranty Data
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List Remarks Data
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Tools

Tools/Read Part Id from Contact Memory

The Tools/Read Part Id from Contact Memory menu item allows you to read a single contact memory button. It will automatically store that data in the database. The current device will be used to read the CMB.
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Using a ButtonLink the program will respond as depicted below. Press the CMB with the ButtonLink and press the OK button on the prompt window. When the data has been read the program will notify you and store the data into the database.
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Tools/Write Part Id To Contact Memory

The Tools/ Write Part Id to Contact Memory menu item allows you to write the current record to a contact memory button. The current device will be used to write to the CMB. 
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Using a ButtonLink the program will respond as depicted below. Press the CMB with the ButtonLink and press the OK button on the prompt window. When the data has been written the program will notify you
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Tools/Read Part Id from Contact Memory

The Tools/Read Part Id from Contact Memory menu item allows you to read a single contact memory button. It will automatically store that data in the database. The current device will be used to read the CMB.
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Using a ButtonLink the program will respond as depicted below. Press the CMB with the ButtonLink and press the OK button on the prompt window. When the data has been read the program will notify you and store the data into the database.
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Tools/Inventory Reconciliation Wizard

The Inventory Reconciliation wizard is a tool designed to quickly compare collected serial number data to the database serial number data. It prompts the user for the required inputs and produces three lists: a matched item list, an unmatched item list, and a missing item list.
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The Wizard starts with a welcome screen. Press the Next button to continue.
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The next panel specifies the source of the collected data. Select the appropriate button and press Next.
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The wizard can automatically add new records to the database. Check the box if this is desired, then press the Next button.
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At this point the wizard has all the information it needs to begin the reconciliation process. Press the Finish button to continue.
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The wizard will display a progress panel listing the steps required and their status. For reconciliation using a ButtonLink, the wizard will prompt you to touch a CMB. Continue touching buttons until your inventory is completed. 
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After all of the data has been collected, the wizard will compare the collected data to that already stored in the database, and it displays the results in the Inventory Reconciliation window. This window separates the data into three areas: Matched Items, Missing Items, and Unreported Items.

[image: image53.png]' Inventory Reconciliation Ed|

Matched ltems!





The Matched Items tab lists those records where the collected data records match the database records. Use the Print button to produce a hard copy report.

The Missing Items tab lists the records from the database that did not match the collected data. Use the Print button to produce a hard copy report.

The Unreported Items tab lists those collected records that did not match the database records. Use the Print button to produce a hard copy report. Use the Add button to store the selected record in the database. Use the Delete button to remove the selected record from the reconciliation process.

A sample Missing Records Report is shown below.
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Tools/Reports

Select Reports and a Dialog block will appear as Report Selection.
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Select one of the following reports:

· Part List Report 

· Nameplate Report

· OEM Report

· Warranty Report

When you wish to view one of the previous four reports you need to select the arrow on the drop down window and select the desired report to be opened, than select OK. This will enable you to view your selected report. All reports have the option of being printed.
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Partlist Report Sorted by Part Number and  Serial Number 

All reports will be sorted by ascending sequence, numeric characters followed by alpha characters.
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Nameplate Report Sorted by Part Number and  Serial Number 

All reports will be sorted by ascending sequence, numeric characters followed by alpha characters.
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OEM Report Sorted by Part Number and  Serial Number 

All reports will be sorted by ascending sequence, numeric characters followed by alpha characters.
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Warranty Report Sorted by Part Number and  Serial Number 

All reports will be sorted by ascending sequence, numeric characters followed by alpha characters.
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Tools/ButtonLaser Utilities

This menu item is only available when the selected contact memory device is a ButtonLaser or ButtonLaser. Each of the following menu items work for either device. Ensure the device is firmly seated in the Downloader before the action is initiated. For more help see Appendix A.

Tools/ButtonLaser 

Tools/ButtonLaser Utilities/Clear ButtonLaser
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Use the Clear ButtonLaser menu item to erase the collected data within the device. 

Tools/ButtonLaser Utilities/Initialize ButtonLaser
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Use the Initialize Button Reader menu item to load the software into the device. This should be performed when the device is not working as expected.

Tools/ButtonLaser Utilities/Recondition ButtonLaser Battery
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Use the Recondition ButtonLaser Battery menu item to intentionally drain the device’s battery so that it may be fully recharged. Remove the device from the Downloader until the “Battery Low” message is displayed on the device. Then place the device into the Downloader again to recharge the battery.

Tools/ButtonLaser Utilities/Initiate ButtonLaserdata Recovery
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Perform the following procedures to load the software into the ButtonLaser:

Place the ButtonLaser into the Downloading Station at the SNT workstation.

Start the SNT System.

Select the Tool/ButtonLaser Utilities the Initialize ButtonLaser will load the Software to ButtonLaser menu item.


Once the Initialize ButtonLaser menu item is selected, the following results should occur:

The ButtonLaser should display a series of asterisks (*) while the software is being loaded. The red LEDs of the ButtonLaser and Downloading Station will flash until the software load is completed.

SNT will display a MacSema window and display a series of asterisks (*) while the software is being loaded.

Once the software is loaded, the MacSema window will be removed from the workstation screen and the ButtonLaser will be displaying the “SELECT RECORD” window.

Next, Press the ButtonLaser’s RECALL key and view the display. The ButtonLaser should display a screen similar to the following:

09FEB00 09:55:35

Wand:161181

Version:1.07

BzSNT(read only)

The first line is the current date and time. Line 2 is the ButtonLaser’s serial number. The third line shows the program’s version number, and line four shows the program name. 

Tools/ButtonLaser Utilities/Get ButtonLaser Version Info
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Use the Get ButtonLaser Version Info menu item to view information about the software loaded in the device.

Security Management
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Assign Privileges
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The Tools/ Security Management/Assign Privileges allows the System Admin to assign user to different levels of security.

Add user
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The Tools/ Security Management/Add User allows the System Admin to add a new user.

Change password
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The Tools/ Security Management/Change Password allows the user to change their password.

ButtonLaser Software Load Procedures

The ButtonLaser software is loaded by using the Tools/ButtonLaser Utilities/Initialize ButtonLaser menu item. Refer to that chapter for specific instructions.

Data Format Instructions

There are no special data formatting instructions. Formatting is automatically performed within the software.

Data Load Instructions

Once a record is stored within the database, simply select the record of interest and select the Tools/Write Part Id to Contact Memory to write data to a contact memory button.

CMB Application Procedures

Refer to the CMB Installation guide for SQQ32.

Appendix A - ButtonLaser Hardware and Software

Hardware Identification

ButtonLaser

The ButtonLaser scans barcodes from a distance of 2 to 20 inches. It also reads CMBs.  The ButtonLaser provides audio and visual cues to aid the user during its operation.  Information seen by the user displays on a 4-line pixel graphic screen.  

Physical Layout

Figure 1 depicts a typical ButtonLaser used by this implementation of the SNT AIT. 
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Figure 1 
ButtonLaser

A typical keypad layout is in Figure 2:

[image: image77.png]



Figure 2 
ButtonLaser Keypad
Controls

Keypad descriptions for the ButtonLaser are in Table 1.  Refer to Figures 1 and 2 for their identification and locations.

KEY
Function Name
Function Description

Scan
Initiates barcode scanning
Turns on a red scanner light, prompting the user to aim the unit at a barcode.

A – Z

SPC
Characters as labeled

SPACE
INACTIVE

F3
Show Previous Field
Show/selects the previous collected data field.

F4
Show Next Record
Show/selects the next collected field.

F1
Show Previous Record
Show/selects the last collected record.  Active/used only on "Select Record" Screen.

F2
Show Next Record
Show/selects the next collected record. Active/used only on "Select Record" Screen.

Del
Delete character
Erases the last character in the data field shown on the display; INACTIVE

+ / -
Plus and minus sign
Generates a dash (-) or plus (+) character on the display; INACTIVE

Shift
--------
Toggles use of the dash (-) or plus (+) character key; INACTIVE

Recall
About
Displays ButtonLaser version info and date/time

3
Save
Save the current  barcode record

0 – 2

4 - 9
Numbers as labeled
INACTIVE

Enter
Action Initiate
Advances the program to the next screen/display

Table 1 
ButtonLaser Controls
The function keys are the primary means for navigating through the different screens and making appropriate selections.  The function keys F3 and F4 are used to TAB through an entire data record from one data field to another.
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The order of display views present to you when using the F3/F4 keys are:


Select Record View

PART NUMBER Field View

CAGE CODE Field View

SERIAL NUMBER Field View

NOMENCLATURE Field View


NSN Field View


VENDOR Field View


DATE OF MANUFACTURE Field View


WARRANTY DATE Field View

Sample representations of each view the user sees follows with a brief description of its purpose.
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SELECT RECORD View: Displays Serial Number (SN) and Part Number (PN) for the records stored.  Using the F1 and F2 keys scrolls forwards and backwards through each record one at a time. You can only navigate from one record to another in the SELECT RECORD view.  

        Figure 3 
SELECT RECORD Field View
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PART NUMBER Field View: Shows the Part number.  The number comes from:

· a CMB read 

Figure 4
PART NUMBER Field View

CAGE Code Field View: Shows the CAGE Code number.
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The number comes from:

· a CMB read  

Figure 5
CAGE Code Field View

SERIAL NUMBER Field View: Shows the Serial number.  

The number comes from:

· a CMB read 

Figure 6
Serial Number Field View

NOMENCLATURE Field View: Shows the nomenclature. 

The nomenclature comes from:

· a CMB read 

Figure 7 
Nomenclature Field View

NSN: Shows the NSN
 The NSN comes from:


· a CMB read 

  Figure 8
            NSN Field View
VENDOR: Shows the Vendor
 The Vendor comes from:


· a CMB read 

Figure 9
Vendor Field View

Date of Manufacture: Shows the Date of manufacture.

The number comes from:


· a CMB read 

 Figure 10

Date Of Manufacture Field View
Warranty Start Date: Shows the Warranty Start Date.

The number comes from:


· a CMB read 

      Figure 11 
Warranty Start Date Field View  

REMARKS: Shows the Remarks 
 The remarks comes from:


· a CMB read 

Figure 12
REMARKS Field View

MODEL NBR Field View: Shows the Model Number.  

The number comes from:

· a CMB read 

Figure 13
MODEL NBR Field View
LOT NBR Field View: Shows the Lot Number. 

 The Lot Number comes from:


· a CMB read 

Figure 14
LOT NBR Field View
Warranty Stop Date: Shows the Warranty Stop Date.

The number comes from:


· a CMB read 

 Figure 15   
Warranty Stop Date Field View

CONTRACTING OFFICE: Shows the Contracting Office
 The Contracting Office comes from:


· a CMB read 

Figure 16
Contracting Off Field View
CONTRACT NBR: Shows the Contract Number
 The Contract Number comes from:


· a CMB read 

Figure 17
Contract Number Field View

AWARD DATE: Shows the Award Date
 The Award Date comes from:


· a CMB read 

Figure 18
Award Date Field View

DATE DELIVERED: Shows the Date Delivered
 The Date Delivered comes from:


· a CMB read 

Figure 19
Date Delivered Field View

EXPIRATION DATE: Shows the Expiration Date 
 The Expiration Date comes from:


· a CMB read 

Figure 20
Expiration Date Field View

RIC: Shows the RIC 
 The RIC comes from:


· a CMB read 

Figure 21
      RIC Field View

GUARANTEED MTBR: Shows the Guaranteed MTBR 
 The Guaranteed MTBR comes from:


· a CMB read 

Figure 22
Guaranteed MTBR Field View

ACTUAL MTBR: Shows the Actual MTBR 
 The Actual MTBR comes from:


· a CMB read 

Figure 23
ACTUAL MTBR Field View

GUARANTEED NFF: Shows the Guaranteed NFF
 The Guaranteed NFF comes from:


· a CMB read 

Figure 24
Guaranteed NFF Field View

ACTUAL NFF: Shows the Actual NFF 
 The Actual NFF comes from:


· a CMB read 

Figure 25
ACTUAL NFF Field View

 NFF: Shows the NFF 
 The NFF comes from:


· a CMB read 

Figure 26
NFF Field View

The function keys F1 and F2 allow the user to scroll through the data records stored in the ButtonLaser.  You can only select a different data record while displaying the Select Record View.

Using the F1/F2 keys while looking at other views has no

Effect
and performs no other operations

Below and to the left of the display screen, is a status LED.  The small light flashes to signal programmed events of the ButtonLaser.  For this implementation of the SNT AIT, the following explains the meaning associated with the flashes a user may see:

· 1 Flash/1 Beep - The ButtonLaser has successfully decoded a barcode, or read from a CMB.  

· 3 Flashes/3 Beeps – 1) A duplicate CMB was read - duplicate CMB records cannot be stored within the ButtonLaser. 2) The ButtonLaser's memory is full. The ButtonLaser’s memory content must be cleared before any additional data may be stored.  Refer to the Operations Section, Clearing ButtonLaser Data for detailed procedures. 

· 10 Flashes - The ButtonLaser has reset to the default monitor program.  The unit must be initialized with the SNT AIT program to continue operation.  There are no audio tones during this condition. Refer to the Operations Section, Software Load for detailed procedures.

· 20 Flashes - The battery charge level is low.  Recharge the ButtonLaser to avoid data loss.  The unit will also emit "tick" sounds while the LED flashes.

Accessories/Cables

The SNT AIT requires several ancillary pieces in order to operate.  The following paragraphs briefly describe their role with the SNT AIT.

Flexible Finger Tip Button Probe

The Flexible FingerTip Button Probe permits the reading of CMBs mounted in tight spaces.  Figure 1 shows the Flexible FingerTip Button Probe attached to the bayonet connector located on the right side of a ButtonLaser.  There are no controls or indicators on this item. Figure 27 depicts the Flexible FingerTip.


Figure 27
Flexible FingerTip
Attaching the Flexible FingerTip Probe involves one step.  The DIN plug connects to the ButtonLaser's DIN receptacle.  Figure 1 shows the probe mated to a ButtonLaser.  The connector uses a sliding retainer ring for lock and unlocking the cable.  Attaching the cable requires aligning the key tabs between the connector and receptacle, then gently pushing the connector onto the receptacle until the outer ring locks.  Removing the cable involves first sliding the outer lock ring back from the ButtonLaser and then pulling the cable connector away from the receptacle.

Downloader/Charger

The Downloader/Charger provides two very essential services for the SNT AIT.  When connected to a desktop PC, it allows the transfer of programs, data, and operational commands between the PC and ButtonLaser.  The other function of the Downloader/Charger is to maintain the ButtonLaser battery voltage level when the ButtonLaser is not in use.

There are indicators available for monitoring tasks performed with the DownLoader/Charger:

· Charge LED - Emits either red or green color light depending on battery charge level of ButtonLaser.  If the battery charge is below 50 percent, the light turns red and remains red until the charge level reaches 50 percent.  Above 50 percent, the LED lights green.

· Incoming Command/Data LED - lights red (flashes) while receiving data and commands from an external source.

· Outgoing Command/Data LED - lights red (flashes) while sending data and commands to an external source.
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Figure 28
Downloader/Charger
Appendix B - ButtonLaser Operations

Each of these paragraphs outlines the typical steps for performing actions as a part of the SNT AIT.  Unless otherwise noted, following these steps assures the operation attempted is successful.

First Time Use

Before using the ButtonLaser for the first time, steps must be taken to ensure successful operations. 

ButtonLaser

Battery Charge

To recharge the internal battery:

· Ensure the download/charge unit is connected to AC power.

· Place the ButtonLaser in the download/charger.  The charge status light may be either red or green.  Red indicates the battery charge level is less than 50 percent of capacity and green represents a charge level greater than 50 percent.

· After the charge light changes from red to green, recommend the ButtonLaser remain in the download/charge unit for 8 - 10 hours.

· Under normal use, the ButtonLaser will keep a charge for 24 hours. Recommend the ButtonLaser be kept in Downloader when not in use.

Software load
Perform the following procedures to load the software into the ButtonLaser:

· Place the ButtonLaser into the Downloading Station at the SNT workstation.

· Start the SNT System.

· Select the Tool/ButtonLaser Utilities the Initialize ButtonLaser will load the Software to ButtonLaser menu item.


Once the Initialize ButtonLaser menu item is selected, the following results should occur:

· The ButtonLaser should display a series of asterisks (*) while the software is being loaded. The red LEDs of the ButtonLaser and Downloading Station will flash until the software load is completed.

· SNT will display a MacSema window and display a series of asterisks (*) while the software is being loaded.

· Once the software is loaded, the MacSema window will be removed from the workstation screen and the ButtonLaser will be displaying the “SELECT RECORD” window.

Next, Press the ButtonLaser’s RECALL key and view the display. The ButtonLaser should display a screen similar to the following:

· 09FEB00 09:55:35

· Wand:161181

· Version:1.07

· BzSNT(read only)

The first line is the current date and time. Line 2 is the ButtonLaser’s serial number. The third line shows the program’s version number, and line four shows the program name. 

Collecting Data from CMBs

To collect data from a CMB, simply touch the CMB of the item you wish to review using the built-in ButtonLaser read head or the Flexible FingerTip probe.  The CMB information appears on the display and is automatically saved as a new record in the ButtonLaser's file.  Multiple records may be collected in this manner. 

Notes:

1) If the same CMB is touched more than once, a duplicate record will not be saved and the user will hear three beeps and see three LED flashes.

2) Once you read a CMB, part of the data shown to the 

User is the status indicator "L".  It appears in the lower 

right corner of the display.

MiniButton
(Note: Not Shown to Scale)








CONTACT MEMORY BUTTON

INSTALLATION MANUAL

Application Instructions for Contact Memory Buttons

1. Materials Required.

A. Contact Memory Button 

B. EPSG50MAN HYSOL 50 ML Manual Dispenser

C. EPSGMIX50 Static Mixing Nozzle

D. EPSGPLUNGER4  Plunger 4:1 Ratio
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E. Adhesive: NOTE: EA-9394 is the RECOMMENDED Adhesive for use in CMB Applications as per NAWC-AD TEST PLAN. 

F. Cleaning Solvent (One of the below listed recommended) 

G. Trichloroethylene (preferred) 

H. Perchloroethylene

I. Methylethylketone

J. Isopropyl Alcohol 

K. Medium Grit Emery Paper 

L. Lint Free Cloth

M. Latex Type Gloves

N. Safety Glasses

O. Heat Lamp (to speed curing time)

P. Scotch Brite

Hysol® is a registered trademark of Dexter Corporation.

Sempak® is a registered trademark of Courtaulds Aerospace, Glendale, CA.

Dexter Adhesive & Coating Systems

2850 Willow Pass Road, Bay Point, CA. 94565    Tel: (925) 458-8000 Fax: (925) 458-8030
2. Safety Precautions

A. Use cleaning solvents and HYSOL EA 9394 in a ventilated area.

B. Wear protective clothing, gloves, and safety glasses as required.

C. Refer to Material Safety Data Sheets for cleaning solvents and HYSOL EA 9394 for    safe handling and use.                            
3. Surface Cleaning and Preparation.

A.  Find Manufactures nameplate / agreed upon location on component and choose an area near to it for placement of the Contact Memory Button.  If the Manufactures Name Plate/ agreed upon location is not accessible when component is installed on the weapon system, then locate an area for placement of the CMB that is accessible. If there is no Manufactures nameplate on the component, then locate an area that is accessible when component is installed on the weapon system for CMB placement.

B. Clean the selected location using one of the cleaning solvents listed in 1.C., preferably Trichloroethylene.

C. Use a lint free cloth to apply the cleaning solvent. Remove all oil and/or solids.

D. Prepare surface for installation of CMB.

E. Clean area with cleaning solvent.

F. Allow area to dry completely.

4. Application of Contact Memory Button.

The following is a picture of the Manual Dispenser with EA9394 Cartridge and EPSGMIX50 Static Mixing Nozzle installed: 

A. Using Hysol EPSG50MAN Manual Dispenser insert 4:1 Ratio Plunger into manual   dispenser.  To insert 4:1 Ratio Plunger push up on silver lever on back of Manual Dispenser and slide Plunger through slot on front of Dispenser.

B. Insert EA 9394 50ML Cartridge onto manual dispenser.  To do this push up on top lever on manual dispenser and insert EA 9394 cartridges into the groove provided and close top.

C. Uncap EA 9394 50ML cartridge and insert EPSGMIX50 Static Mixing Nozzle.
D. Thoroughly mix HYSOL EA 9394 as per manufactures mixing instructions. See Instructions below: 

       WARNING:  THIS HYSOL KIT SHOULD BE USED WITH ADEQUATE VENTILATION. AVOID EXPOSURE TO VAPORS. AVOID CONTACT WITH SKIN AND EYES. REFER TO PRODUCT MATERIAL SAFETY DATA SHEET FOR SPECIFIC HANDLING AND SAFETY PRECAUTIONS BEFORE USING THIS HYSOL SEMPAK PACKAGE. FOR OPTIMUM PERFORMANCE, MATERIAL AND KIT SHOULD BE 77°F/25 °C.

                                        HYSOL® SEMPAK® DUAL CARTRIDGE/ STATIC MIXER KIT

                                                                   INSTRUCTIONS FOR USE

          1.
Place kit into applicator gun.

2.
Remove cap and expel a small amount to assure even ratio and even


flow, typically a one to two inch bead is satisfactory.

3.
Clear orifice if necessary and attach static mix nozzle.

4.
Dispense a quarter inch wide bead the length of the static mixer to


assure proper mixing before usage. Do not use this purged material,


or any material, which does not appear homogenous in color or


consistency.

5.
Repeat step 4 upon every change of static mixer nozzle.

6.
Replace cap to store.



/

E. RECOMMENDATIONS FOR USE OF THIS PRODUCT ARE BASED UPON TESTS WE BELIEVE TO BE RELIABLE. MANUFACTURER AND/OR SELLER ARE NOT RESPONSIBLE FOR RESULTS WHERE PRODUCT IS USED UNDER CONDITIONS BEYOND OUR CONTROL. UNDER NO CIRCUMSTANCES WILL MANUFACTURER AND/OR SELLER BE LIABLE FOR DAMAGES TO ANYONE IN EXCESS OF THE PURCHASE PRICE OF THIS PRODUCT.

F. Apply only enough HYSOL EA 9394 to the area, so that when the CMB is installed a small bead will form around the outer edges of the CMB. Be sure to use latex type gloves when handling HYSOL EA 9394.

G. Lightly press the CMB on to the HYSOL EA 9394. Ensure a small bead of adhesive forms around the edges of the CMB.  The following picture shows a CMB with the bead of EA 9394 around the edges:
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H. Hold the CMB in place with slight pressure for about 5 to 10 minutes. If any adhesive gets on the top of the CMB, gently wipe clean with one of the cleaning solvents.

I. Handling strength for HYSOL EA 9394 will occur in 8 hours at 77'F/25'C. HYSOL EA 9394 maybe cured for 3 to 5 days at 77'F/25'C to achieve normal performance. Curing can be accelerated by placing a heat lamp on the area for 1 hour at 150'F/66'C. When using heat lamp for curing, be sure to follow heat lamp manufacture instruction for safe operations. Ensure all flammable materials are clear of the area to be heat-treated.

J. Have a Quality Assurance Representative (QAR) inspect area for FOD in all critical area’s or on safety of flight critical components. Have a Collateral Duty Inspector (CDI) inspect area for FOD in non-critical area or non-safety of flight critical components.

K. Clean and paint any exposed component surface area after curing of the HYSOL EA 9394. Follow proper maintenance procedures in type weapon systems Maintenance Instruction Manuals. Do not get primer or paint on top portion of CMB, because this could affect the reading and writing to the CMB.
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PART NUMBER
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SERIAL NUMBER
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NOMENCLATURE


WC8 WINCH INTERFACE CCA
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WARRANTY START DATE
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DATE MANUFACTU


04/20/1999
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VENDOR


Vendor Name
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CONTRACTING OFF
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REMARKS
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Part #BMEWK8


Cage Code 03BF3





Dimensions: 


Flange Dia. = 14.3 mm


Flange Thick. = 0.2 mm


Button Dia. = 10.7 mm


Button Height = 3 mm





Button Dia.


  10.7 mm





Button Height


3 mm





Flange Thick.


0.2 mm
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